
 1 

Docking Study with HyperChem Release Notes 
 

 

 

This document lists additional information about Docking Study with HyperChem family,  

Essential, Premium Essential, Professional, Advanced, Ultimat, and Cluster. 

 

 

 

Current Revision 
 

Revision H1 (Version 8.1.5) 

 

 

 

Current Versions of Module Programs 
 

The module programs interface to HyperChem using its Chemist's Developer Kit (TclPro). 

These control HyperChem as well as its back-end computational programs. 

 

================================================================================= 

File Name   Full Name  Version  Application 

----------------------------------------------------------------------------------------------------------------------------------------- 

controllerDS.tbc  ControlCenterDS.tbc  2.40  TclPro1.2 

correctionDS.tbc   GeometryCorrectionDS.tbc  2.10  TclPro1.2 

interfaceDS.tbc  InterfaceSelectionDS.tbc  2.20  TclPro1.2 

piefii.tbc   PIEFII.tbc   5.24  TclPro1.2 

dockingstudy.tbc  DockingStudy.tbc   6.26  TclPro1.2 

dockviewer.tbc  DockViewer.tbc   3.56  TclPro1.2 

moldimension.tbc  MolDimension.tbc   2.61  TclPro1.2 

molbrowser.tbc  MolBrowser.tbc   2.09  TclPro1.2 

mftapi.dll       1.03  Win32 

mfsurf.dll       1.00  Win32 

ffcontrol.exe      1.00  Win32 

mfhcinter.exe      1.01  Win32 

mfupdate.exe      1.05  Win32 

----------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

Sample Files 
 

================================================================================= 

Test 

Tutorial_1 

2lbd_rec.hin 

2lbd_atra.hin 

am80.hin 

2lbd_rec.sel 

2lbd_rec_surf.sel 

2lbd_rec_2.flg 

2lbd_rec_2.sur 
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2lbd_rec_3.mmf 

am80.sdf 

am80.rdf 

am80.cdx 

rar.sdf 

----------------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

Changes 
 

Revision H (Package Version 8.x): Current Version 

Revision G (Package Version 7.x): Added New Fast Screenings Algorithm and Related Function 

Revision F (Package Version 6.x): Improved Versions for Windows 8.1, 8, 7, and Vista 

Revision E (Package Version 5.x): Renewal Version 

Revision D (Package Version 4.x): C++ Dynamic Link Library Based Version 

Revision C (Package Version 3.x): Nucleic Acid- and Compound-flexible Docking Support Version 

Revision B (Package Version 2.x): HyperChem8.03 Compatible Version 

Revision A (Package Version 1.x): First Available Version 

 

Revision H1 

 

In the Revision H1, AutoDock Vina interface is available for performing virtual screenings, and the file 

conversion function is available for performing the fragment molecular orbital programs and is compatible to the 

CHARMM-based NAMD molecular dynamics calculations. 

Default force field was changed to AMBER99 from AMBER94. Manually changed atomic charges are retained 

through all module programs. 

 

Control Center DS ver. 2.40: 

Changes in version 2.40 

1. Minor change in loading PDB for nucleotides. 

Changes in version 2.39 

1. Minor change in loading PDB. 

Changes in version 2.38 

1. Improved the MOL2 conversion. 

Changes in version 2.35 

1. Improved the Conversion PDB to CHARMM-based NAMD PDB command for Metals. 

Changes in version 2.34 

1. Added the Conversion PDB to CHARMM-based NAMD PDB command to the Utilities menu for 

obtaining the NAMD compatible PDB. 

Changes in version 2.33: 

1. Added the counterion command to neutralize the system. 

Changes in version 2.32 

1. Added the Export function which converts the opened molecular system in PDB or HIN format to one in 

Tripos MOL2, AutoDock PDBQT, and MDL SDF formats using Babel program. 

2. Added the Conversion of CHARMM-based NAMD PDB command to the Utilities menu for obtaining the 

formal PDB format file from the modified PDB file by VMD (NAMD). 

3. Added the Prepare PDB File for FMO (Fragment Molecular Orbital) command to the Utilities menu for 

obtaining the BioStationViewer (ABINIT-MP) and Fu and Facio (GAMESS) readable PDB file from the 

formal PDB format file. 

4. Default force field was changed to AMBER99 from AMBER94. 

5. Modified a function getting HyperChem version information. 

6. Improved the PDB format corresponding to molecular system which contains from 100,000 atoms to 
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999,999 atoms. 

 

Geometry Correction DS ver. 2.10: 

Changes in version 2.10 

1. Corresponded to manual atomic charges which are modified by user. 

2. Modified a function getting HyperChem version information. 

 

Interface Selection ver. 2.20: 

Changes in version 2.20 

1. Added the Select Backbone command to the Selection menu for selecting the peptide and nucleotide 

backbone. 

2. Corresponded to manual atomic charges which are modified by user. 

3. Default force field was changed to AMBER99 from AMBER94. 

4. Modified a function getting HyperChem version information. 

Bugs fixed in version 2.20 

1. Fixed minor bugs. 

 

PIEFII ver. 5.24: 

Changes in version 5.24 

1. Added the interface for AutoDock Vina commands to the Tool menu. 

2. To generate the AutoDock Vina configuration file, added the Make AutoDock Vina Configuration File 

option to the Tune Search Area function in the Setup Option. 

3. Modified a function getting HyperChem version information. 

 

Docking Study ver. 6.26: 

Changes in version 6.26 

1. Improved the docking screening at the united atom conditions. 

Changes in version 6.24 

1. Became available for docking the restrained compound (select-name: COMPOUND_x). 

Changes in version 6.23 

1. In screening mode, docking simulations of trial compounds in Tripos ML2 (MOL2) format were 

supported. 

2. Corresponded to manual atomic charges which are modified by user. 

3. Default force field was changed to AMBER99 from AMBER94. 

4. Modified a function getting HyperChem version information. 

Bugs fixed in version 6.22 

1. Fixed a bug of the Automatic Conformation Search method. 

 

Dock Viewer ver. 3.56: 

Changes in version 3.56 

1. Improved the Export SDF from MMF. 

Changes in version 3.55 

1. Added the AutoDock menu to reflect (in part) the flexible pdbqt. 

Changes in version 3.52 

1. Added a find function for compound name. 

2. The Distance Filter function can output the filtered mmf file. 

Changes in version 3.42 

1. Available for the ZINC ID. 

Changes in version 3.40 

1. The Load Hit Compound command can read the rDock results to view and analyze the docking modes 

when Babel program has been installed to Windows. 

Changes in version 3.39 

1. The Load Hit Compound command can read the AutoDock Vina and rDock results to view and analyze the 
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docking modes when Babel program has been installed to Windows. 

2. Added the Convert Ligand PDBQT to PDB Format command to the Tool menu to calculate the RMSD 

value of the AutoDock Vina results using the converted ligand in pdb format if Babel program is available. 

3. Corresponded to manual atomic charges which are modified by user. 

4. Default force field was changed to AMBER99 from AMBER94. 

5. Improved the Output Hit List function. 

6. Added the Hydrogen Bondings function, but this function competes to molecular surface function, so that 

the function behaves unexpectedly. 

7. Modified a function getting HyperChem version information. 

Bugs fixed in version 3.53 

1. Fixed a bug of command for converting an MMF file to SDF file. 

Bugs fixed in version 3.41 

1. Fixed a bug that Load Hit Compounds command cannot read abnormal hit compounds. 

Bugs fixed in version 3.39 

1. Fixed a bug that Load Hit Compounds command cannot read the PDBQT file without the Name tag. 

 

Mol Dimension ver. 2.61: 

Changes in version 2.61 

1. Added the option for filtering organometallic compounds. 

Changes in version 2.60 

1. Added the option for preparing the individual pdbqt files without pH dependent protonation. 

Changes in version 2.59 

1. Added the option for preparing the individual sdf files using ID in the sequential SDF file. 

Changes in version 2.58 

1. Added the option for changing the protonation state of azole-type ring such as imidazole. 

Changes in version 2.55 

1. Changed the generation function of stereo isomers using chiral information in MDL file. 

2. Improved the function to generate preferentially equatrial configuration of cyclic substituents. 

Changes in version 2.53 

1. Available for the ZINC ID. 

Changes in version 2.52 

1. Supported the suitable molecular ID for converting to the PDBQT format. 

Changes in version 2.50 

1. Supported the multiple compound MOL2 file. 

2. The Separate File option can prepare the single AutoDock PDBQT files from the multiple compound SDF 

and MOL2 files to perform the AutoDock Vina virtual screenings. 

3. Added the AutoDock Vina Setting & Screenings command to the Setup menu which can prepare screening 

batch file and perform the screenings when AutoDock Vina has been installed to Windows. 

4. Added the Combine Vina OUT.PDBQT Files command to the Setup menu to combine all AutoDock Vina 

result pdbqt files into single pdbqt file. 

5. Default force field was changed to AMBER99 from AMBER94. 

6. Modified a function getting HyperChem version information. 

7. Added the gen3D option for preparing Vina ligands of which 3D structures are abnormally generated. 

8. Added the function that recognizes the aromatic rings. 

Bugs fixed in version 2.51 

1. Fixed the problem with respect to the molecular name in the PDBQT files. 

Bugs fixed in version 2.50 

1. Fixed minor bugs. 

 

Mol Browser ver. 2.09: 

Changes in version 2.09 

1. Added the Save List command. 

Changes in version 2.08 
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1. Modified a function getting HyperChem version information. 

 

Revision G1 

 

In the Revision G1, the Automatic Conformation Search Method is available for performing fast screenings. 

 

Control Center DS ver. 2.13: 

 

Geometry Correction DS ver. 2.08: 

 

Interface Selection ver. 2.15: 

 

PIEFII ver. 5.08: 

 

Docking Study ver. 6.06: 

Changes in version 6.06 

1. Added the Automatic Conformation Search Method. 

2. Added the option skipping the conformation search for performing the fast screenings. 

 

Dock Viewer ver. 3.13: 

Changes in version 3.13 

1. Added the RMSD data to the Analyze Mode List in order to confirm the precision of the re-docking study. 

 

Mol Dimension ver. 2.22: 

Changes in version 2.22 

1. Added a function for preparing hypervalent compounds. 

2. Added a function for separating a big SDF file into several files of a specified size of compounds. 

3. Added a function for preparing 3D database in Tripos MOL2 format. 

4. Added a function for skipping conversion using maximum number of heavy atoms. 

 

Mol Browser ver. 2.07: 

Changes in version 2.07 

1. Added a function for viewing compounds in Tripos MOL2 format. 

 

Revision F3 

 

In the Revision F3, pseudo-clustering function was improved. 

 

Control Center DS ver. 2.12: 

Changes in version 2.12 

1. Improved window control for Windows8 and 8.1. 

 

Geometry Correction DS ver. 2.07: 

Changes in version 2.07 

1. Improved window control for Windows8 and 8.1. 

 

Interface Selection ver. 2.13: 

  Added into the package as new module program from Homology Modeling Professional for HyperChem 

package. 

Changes in version 2.13 

1. Improved window control for Windows8 and 8.1. 

 

PIEFII ver. 5.06: 
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Changes in version 5.06 

1. Improved window control for Windows8 and 8.1. 

 

Docking Study ver. 5.22: 

Changes in version 5.22 

1. Improved window control for Windows8 and 8.1. 

2. Improved pseudo-clustering function for parallel computing. 

 

Dock Viewer ver. 3.07: 

Changes in version 3.07 

1. Improved window control for Windows8 and 8.1. 

 

Mol Dimension ver. 2.14: 

Changes in version 2.14 

1. Improved window control for Windows8 and 8.1. 

2. Improved pseudo-clustering function for parallel computing. 

3. Supported the Tripos MOL2 format. 

4. Added a rendering option for original file. 

 

Mol Browser ver. 2.05: 

Changes in version 2.05 

1. Improved window control for Windows8 and 8.1. 

 

Revision F2 

 

In the Revision F2, both the classical rigid-body and partial docking conditions were supported in Docking Study 

module program. 

 

Control Center DS ver. 2.10: 

Changes in version 2.10 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

Bugs fixed in version 2.10 

1. Fixed some minor bugs. 

 

Geometry Correction DS ver. 2.06: 

Changes in version 2.06 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

 

PIEFII ver. 5.04: 

Changes in version 5.04 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

Bugs fixed in version 5.04 

1. Fixed some minor bugs. 

 

Docking Study ver. 5.20: 

Changes in version 5.20 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

2. Added the classical rigid-body docking conditions for performing loose and speedy docking simulations. 

3. Added the classical partial docking conditions for performing loose and speedy docking simulations. 
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4. Supported the combinations between the classical rigid-body docking conditions and the classical partial 

docking conditions. 

Bugs fixed in version 5.20 

1. Fixed some minor bugs. 

 

Dock Viewer ver. 3.05: 

Changes in version 3.05 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

Bugs fixed in version 3.05 

1. Fixed some minor bugs. 

 

Mol Dimension ver. 2.10: 

Changes in version 2.10 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

Bugs fixed in version 2.10 

1. Fixed some minor bugs. 

 

Mol Browser ver. 2.04: 

Changes in version 2.04 

1. Use restriction of the specific HyperChem versions (8.0.0 - 8.0.2) was removed in order to recognize the 

present HyperChem version (8.0.10). 

Bugs fixed in version 2.04 

1. Fixed some minor bugs. 

 

Revision F1 

 

The Revision F1 has been improved mainly for Windows 7. 

 

Control Center DS ver. 2.09: 

Changes in version 2.09 

1. Improved for Windows 7 and Vista. 

2. Improved the "Update" command. 

 

Geometry Correction DS ver. 2.05: 

Changes in version 2.05 

1. Improved for Windows 7 and Vista. 

 

PIEFII ver. 5.03: 

Changes in version 5.03 

1. Improved for Windows 7 and Vista. 

2. Improved the "Record Selections" and "Previous Selections" options. 

Bugs fixed in version 5.03 

1. Fixed a bug related to the "Ligand Distance Selection" option. 

 

Docking Study ver. 5.07: 

Changes in version 5.07 

1. Improved for Windows 7 and Vista. 

2. Improved the "Cluster Option" menu. 

Bugs fixed in version 5.07 

1. Fixed a bug related to the "Ligand Distance Selection" option. 

 



 8 

Dock Viewer ver. 3.04: 

Changes in version 3.04 

1. Improved for Windows 7 and Vista. 

2. Improved the "Filter By Distance" option. 

3. Improved the labels involved in the "Atom Labels" option. 

Bugs fixed in version 3.04 

1. Fixed a bug related to the "Ligand Distance Selection" option. 

2. Fixed a bug related to the File Format Error of the "Load Hit Compound" command. 

 

Mol Dimension ver. 2.05: 

Changes in version 2.05 

1. Improved for Windows 7 and Vista. 

 

Mol Browser ver. 2.03: 

Changes in version 2.03 

1. Improved for Windows 7 and Vista. 

 

Revision E2 

 

In the Revision E2, some clustering functions for virtual screening have been improved mainly. 

 

Control Center DS ver. 2.05: 

Changes in version 2.05 

1. Added the function that removes the snapshot file information from the HIN file. 

2. Altered the updating policy of the Preference. 

 

Geometry Correction DS ver. 2.02: 

 

PIEFII ver. 5.00: 

 

Docking Study ver. 5.04: 

Changes in version 5.04 

1. Changed the folder location of temporal coordinate file to the project folder from the trial compound 

folder. 

2. Altered the timing for determining output file names. 

3. Secured further the file operations under the clustering conditions (secure file operations can not be 

perfected due to user dependences). 

4. Added the structural selection check function. 

5. Improved the force fied information of the MMF file. 

 

Dock Viewer ver. 3.01: 

Changes in version 3.01 

1. Improved the structural renderings of a trial compound under the Browing mode. 

2. Add the window lowering function to the Browse Compound window. 

3. Improved the z-clipping function. 

Known Problems 

1. In the Advanced mode wherein the HyperChem menu bar and tool bar are accessible, there are cases in 

which all structures are depicted instantaneously during browsing hit compounds under the "Show Selection 

Only" condition. 

 

Mol Dimension ver. 2.02: 

Changes in version 2.02 

1. Added the Serial Number option to the Molecule Name option in order to generate the converted file 
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name. 

2. Added the force fied information to the Index.lst file. 

 

Mol Browser ver. 2.00: 

 

Revision E1 

 

Revision E1 renews user interface of all module programs. All modules carry a window management function. 

 

Control Center DS ver. 2.04: 

Changes in version 2.04 

1. Extended the Window Management function. 

2. Added the Forced Termination function to the Close button. 

3. Added the Make Folder command to the File menu. 

 

Geometry Correction DS ver. 2.02: 

Changes in version 2.02 

1. Extended the Window Management function. 

 

PIEFII ver. 5.00: 

Changes in version 5.00 

1. Extended the Window Management function. 

2. Added the "Ligand Distance Selection" option. 

3. Added the "Rendering" option for rendering structures individually. 

4. Added the "Window Color" and some Secondary Structure options. 

Bugs fixed in version 5.00 

1. Fixed a problem for the "Minimize Search Box" command. 

 

Docking Study ver. 5.02: 

Changes in version 5.02 

1. Extended the Window Management function. 

2. Added the "Residue Selection", "Distance Selection", and "Ligand Distance Selection" options. 

3. Added the "Rendering" option for rendering structures individually. 

4. Added the "Color Palette", "Window Color",  and some Secondary Structure options. 

Bugs fixed in version 5.02 

1. Fixed a problem for the "Get Flags for Docking" command. 

 

Dock Viewer ver. 3.00: 

Changes in version 3.00 

1. Extended the Window Management function. 

2. Added the "Residue Selection", "Distance Selection", and "Ligand Distance Selection" options. 

3. Rearranged some rendering commands into the "Rendering" option for rendering structures individually. 

4. Added the "Edit Hit Compound File" option for further screening the hit compound by the interaction 

energy. 

 

Mol Dimension ver. 2.00: 

Changes in version 2.00 

1. Extended the Window Management function. 

 

Mol Browser ver. 2.00: 

Changes in version 2.00 

1. Extended the Window Management function. 

Bugs fixed in version 2.00 
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1. Fixed a problem for opening another compound file. 

 

Revision D1 

 

Revision D1 supports the simultaneous docking simulations at multiple docking sites. 

Also, additional flexible docking algorithm becomes available for performing docking simulations with large 

structural changes such as transformation from apo to holo conformation. 

 

Control Center DS ver. 1.14: 

Changes in version 1.14 

1. Added a function for making connection table of a small molecule. 

2. Added a instance management function of HyperChem. 

3. Added a check function for the "Mode" option of HyperChem 8.0. 

4. Added the Molecular System Information option. 

5. Added the interface to the HyperChem Renderings option. 

6. Added a Keyboard help. 

7. Added the "Mechanics Preferences" for setting default parameters of particular force fields. 

Bugs fixed in version 1.14 

1. Fixed a problem that occurs when the "Save As" command is used using an unavailable file name. 

 

Geometry Correction DS ver. 1.23: 

No Changes. 

 

PIEFII ver. 4.00: 

Changes in version 4.00 

1. Changed the mathematical static library to the corresponding C++ dynamic link library. 

2. Added the Residue Selection function that uses residue number and distance conditions for selecting a 

desired residue. 

3. Added a Keyboard help. 

Bugs fixed in version 4.00 

1. Fixed a listbox error that occurs using together with Control or Shift key. 

 

Docking Study ver. 4.07: 

Changes in version 4.07 

1. Optimized the computational algorithms. 

Changes in version 4.02 

1. Changed the mathematical static library to the corresponding C++ dynamic link library. 

2. Supported the simultaneous docking simulations at multiple docking sites. 

3. Added a docking algorithm for performing docking simulations with large structural changes such as 

transformation from apo to holo conformation. 

4. Added a Keyboard help. 

Bugs fixed in version 4.02 

1. Fixed a listbox error that occurs using together with Control or Shift key. 

2. A part of force field settings was moved to the "Mechanics Preferences" in the Control Center module 

program due to malfunction of options such as dielectric constant and 1-4 scale factor for Amber94, 96, 99, 

Charmm19, 22, and 27. 

 

Dock Viewer ver. 2.00: 

Changes in version 2.00 

1. Changed the mathematical static library to the corresponding C++ dynamic link library. 

2. Added the Filter option by distance from specified atoms. 

3. Improved the Molecular Surface settings. 

4. Added a Keyboard help. 
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Bugs fixed in version 2.00 

1. Fixed a listbox error that occurs using together with Control or Shift key. 

 

Mol Dimension ver. 1.17: 

Changes in version 1.17 

1. Improved some commands. 

Bugs fixed in version 1.17 

1. Fixed a listbox error that occurs using together with Control or Shift key. 

 

Mol Browser ver. 1.04: 

1. Added a Keyboard help. 

 

Revision C1 

 

Revision C1 supports the nucleic acid- and compound-flexible docking simulations as well as protein- and 

compound-flexible docking simulations. 

Revision C1 supports the special options for performing non-restricted in-silico screenings. The special options 

are optional functions. Contact us for details. 

Some useful icons such as "Undo" and "Mouse Mode" icons are available from the module programs. 

Menu bar and toolbar of HyperChem are changed to the "Safety Mode" in default. 

 

Control Center DS ver. 1.13: 

Changes in version 1.13 

1. Changed the license management. 

2. Improved the process management. 

3. Supported a nucleic acid molecule system. 

4. Added the mouse mode to the "Utilities" menu. 

5. Changed default settings to the "Safety Mode". 

 

Geometry Correction DS ver. 1.23: 

Changes in version 1.23 

1. Changed the license management. 

 

PIEFII Limited ver. 3.06: 

Changes in version 3.06 

1. Added the "Color Palette" option. 

2. Improved the interaction point search algorithm. 

Changes in version 3.03 

1. Change license management. 

2. Supported the PIEFII function for a nucleic acid. 

3. Added the "Boundary Condition" options for searching an interaction point on the molecular surface. 

4. Improved the interaction point search algorithm. 

5. Added some useful options for the molecular surface conditions. 

6. Improved the "Minimize Search Box" function. 

7. Updated version of the parameter file to 1.70 from 1.60. 

8. Added the "Mouse Mode Icons" window. 

9. Added the "Undo" function for a wrong mouse right-button operation. 

 

Docking Study ver. 3.23: 

Changes in version 3.23 

1. Changed the outputted file name of a complex to xxx_conformation_mode. 

Changes in version 3.22 

1. Changed the license management. 
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2. Supported the non-restricted screening option using the conventional docking simulations. 

3. Improved the "Topology Check" option. 

4. Added the "Concise Output" option to reduce output contents. 

5. Supported the nucleic acid- and compound-flexible docking simulations. 

6. Tuned up the code. 

7. Added the "Mouse Mode Icons" window. 

8. Added the "Undo" function for a wrong mouse right-button operation. 

 

Dock Viewer ver. 1.35: 

Changes in version 1.35 

1. Added the "Color Palette" option. 

2. Added the docking mode information to the "Copy Current List" option. 

Changes in version 1.33 

1. Change license management. 

2. Supported a nucleic acid. 

3. Added some rendering options for nucleic acid. 

4. Added the "Mouse Mode Icons" window. 

5. Added the "Undo" function for a wrong mouse right-button operation. 

Bugs fixed in version 1.33 

1. Fixed a problem that the program could not communicate with HyperChem when the "Demonstration" 

window was moved. 

 

Mol Dimension ver. 1.15: 

Changes in version 1.15 

1. Changed the license management. 

2. Added the "Maximum RMS Gradient" settings to the MM+ and QM algorithms. 

3. Supported the non-restricted conversion option. 

4. Supported the "Restart" option for the killed conversion. 

 

Mol Browser ver. 1.03: 

Changes in version 1.03 

1. Changed the license management. 

 

Revision B1 

 

Revision B1 supports a new version (8.03 and the earlier versions) of HyperChem as well as a new version (3.1 

and the earlier versions) of the Protein Data Bank format. 

 

Control Center DS ver. 1.10: 

Changes in version 1.10 

1. Added a function which can convert the PDB name system in the version 3.x into the HyperChem name 

system. 

Changes in version 1.09 

1. Supported HyperChem8.03. 

 

Geometry Correction DS ver. 1.21: 

Changes in version 1.21 

1. Supported HyperChem8.03. 

 

PIEFII Limited ver. 2.31: 

Changes in version 2.31 

1. Supported HyperChem8.03. 
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Docking Study ver. 3.17: 

Changes in version 3.17 

1. Supported HyperChem8.03. 

 

Dock Viewer ver. 1.29: 

Changes in version 1.29 

1. Supported HyperChem8.03. 

2. Supported the simultaneous browsing and analysis of the results obtained from some docking simulations. 

3. Added a function which can output a hit list sorted by some keywords such as name, interaction energy, 

and the number of conformations. 

 

Mol Dimension ver. 1.13: 

Changes in version 1.13 

1. Supported some combinations of calculations for performing a fast conversion and a precise conversion. 

2. Supported file format conversion function for other 2D-3D converter programs. 

3. Supported the constraint function for an amide group. 

4. Improved a resulting structure. 

Changes in version 1.12 

1. Supported HyperChem8.03. 

 

Mol Browser ver. 1.01: 

Changes in version 1.01 

1. Supported HyperChem8.03. 

2. Became available from the "Modules" menu of the Control Center. 

 

Revision A3 

 

Some grades are added to the package for supporting in silico screenings. 

A new module program, Mol Browser, is available for browsing a trial compound prepared by the Mol Dimension 

program. 

Revision A3 improved the structural rendering function. 

 

Control Center DS ver. 1.07: 

Changes in version 1.07 

1. Improved some commands. 

Changes in version 1.06 

1. Added the "Use OpenGL" command to the "Utilities" menu for the HyperChem version 7.5 or the later 

version. 

Bugs fixed in version 1.06 

1. Fixed minor bugs. 

Changes in version 1.05 

1. Changed a default style to the Tubes style for the HyperChem version 7.5 or the later version. 

2. Improved check function of parameters in the Preferences. 

Changes in version 1.04 

1. Improved file opening function. 

 

Geometry Correction DS ver. 1.19: 

Changes in version 1.19 

1. Improved treatment for a hydrogen bond. 

Bugs fixed in version 1.17 

1. A problem that arises from a hydrogen bond was fixed. 

Bugs fixed in version 1.16 

1. Fixed minor bugs. 
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Changes in version 1.15 

1. Changed a default style to the Tubes style in the HyperChem version 7.5 or the later version. 

 

PIEFII Limited ver. 2.29: 

Changes in version 2.29 

The flag numbering function became available using the "Show Flag Number" command from the "Option" 

menu. 

Bugs fixed in version 2.28 

1. Fixed minor bugs. 

Changes in version 2.28 

1. Changed a default style to the Tubes style in the HyperChem version 7.5 or the later version. 

2. Added the "Selection Color" command to the "Option" menu. 

3. Added the "Flag Radius" option to the "Option" menu. 

4. Applied the automatic rendering method to the "Merge Ligand" and "Select Ligand" command in the 

HyperChem version 7.5 or the later version. 

5. Changed a default style of a flag to the Balls style in the HyperChem version 7.5 or the later version. 

6. Added the "Change Mode" function which can switch between the non-Open GL mode and the Open GL 

mode in the HyperChem version 7.5 or the later version. 

7. Added the "Show Selection Only" command to the main window. 

8. Added the "Flag Information" option which can selectively edit the individual flags. 

9. Changed to a new flag format. 

Changes in version 2.22 

1. Updated to the multiple-compound version. 

 

Docking Study ver. 3.13: 

Changes in version 3.13 

1. Improved treatment for a hydrogen bond. 

Changes in version 3.12 

1. Improved some commands. 

2. Improved log information to add the detailed rejection information of each step. 

3. Added the interface of the Mol Browser program. 

Bugs fixed in version 3.11 

1. Fixed minor bugs. 

Changes in version 3.10 

1. Changed a default style to the Tubes style in the HyperChem version 7.5 or the later version. 

2. Added the "Selection Color" command to the "Option" menu. 

3. Added the "Flag Radius" option to the "Option" menu. 

4. Applied the automatic rendering method to the "Merge Ligand" and "Select Ligand" command in the 

HyperChem version 7.5 or the later version. 

5. Changed a default style of a flag to the Balls style in the HyperChem version 7.5 or the later version. 

6. Supported a new flag format. 

Changes in version 3.08 

1. Updated to the multiple-compound version. 

2. Added a function that can control the cutoff condition for the final hit compounds. 

3. Added a function that can finely prepare the "Boundary Box". 

4. Changed the accessibility of the "Compound Info" option. 

5. Added a function which can automatically add the torsion information to the corresponding HIN file from 

the "Compound Info" window. 

6. Added some useful options to the "Compound Info" window, i.e., "Total Conformations", "Open 

Structure", and "Open HIN file". 

 

Dock Viewer ver. 1.25: 

Changes in version 1.25 
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1. Improved treatment for a hydrogen bond. 

Changes in version 1.24 

1. Improved the "Hide Protein" function. 

Changes in version 1.23 

1. Added a series of "Hide" commands (for HyperChem 7.5 or later). 

2. Added the "Select Waters" and the "Select Others" commands. 

3. Added the "Stereo View" command. 

Changes in version 1.22 

1. Improved some commands. 

Changes in version 1.20 

1. Improved the automatic labeling function. 

Changes in version 1.19 

1. Changed a default style to the Tubes style in the HyperChem version 7.5 or the later version. 

2. Added the "Flag Radius" option to the "Option" menu. 

3. Changed a default style of a flag to the Balls style in the HyperChem version 7.5 or the later version. 

4. Supported a new flag format. 

5. Added the "Demonstration" function to the "Tool" menu. 

6. Added the "Calculation" menu for the semi-empirical single-point calculations. 

Changes in version 1.15 

1. Added the "Show All" function to the main window. 

2. Improved the "Show Selection Only" function. 

Changes in version 1.14 

1. Changed some selection options, i.e., "Select Protein," "Select Backbone," and "Select Water," to the 

corresponding rendering options. 

2. Added the "Select Others" function to the "Option" menu. 

3. Improved the automatic rendering function. 

Bugs fixed in version 1.14 

1. Fixed a problem that an error occurs during loading the large number of hit compounds. 

 

Mol Dimension ver. 1.11: 

Changes in version 1.11 

1. Improved treatment for a hydrogen bond. 

2. Added the Mol Browser interface. 

Changes in version 1.10 

1. Improved the "Force Field Option" and the "MM Algorithm" options. 

2. Added a command, i.e., "Browse 3D", to the "View" menu for calling up the Mol Browser program. 

Bugs fixed in version 1.09 

1. Fixed minor bugs. 

Changes in version 1.08 

1. Improved the log file. 

2. Moved the "Convert" command to the "Compute" menu. 

3. Moved the "Show Hydrogens" option to the "Setup" menu. 

4. Moved the "Option" option to the "Compute" menu. 

5. Added the "Force Field Option" option to the "Setup" menu. 

6. Added the "MM Algorithm" option to the "Setup" menu. 

7. Added the "SCF Control" option to the "Setup" menu. 

8. Added the "QM Algorithm" option to the "Setup" menu. 

Changes in version 1.06 

1. Updated to the multiple-compound version. 

2. Added a function that can assign a chiral center using the stereo tag in the SD or RD format. 

 

Mol Browser ver. 1.00: 

Added newly into the package. 
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Revision A2 

 

Revision A2 improved reliability through practical uses. 

Moreover, revision A2 fully supports functions of HyperChem7.52 such as the OpenGL rendering function. 

 

Control Center DS ver. 1.03: 

Changes in version 1.03 

1. Changed treatment for the Geometry Correction module program. 

 

Geometry Correction DS ver. 1.14: 

Changes in version 1.14 

1. Moved the save function to the end of the program. 

2. Added a function which records a tag into the HIN file. 

 

PIEFII Limited ver. 2.21: 

Changes in version 2.21 

1. Updated version of the parameter file to 1.60 from 1.50. 

Bugs fixed in version 2.21 

1. Fixed a problem that occurred at termination of the program. 

 

Docking Study ver. 3.06: 

Changes in version 3.06 

1. Added the "Export Selections" command to the "File" menu. 

2. Improved the interface to the "Topological Similarity Check" option. 

Changes in version 3.05 

1. Improved some entry boxes in the "Advanced" window. 

Bugs fixed in version 3.05 

1. A problem arising from an overlapped compound was fixed. 

Changes in version 3.03 

1. The function of the default user parameter settings becomes available for exporting and importing. 

2. Added a parameter with respect to the "Topological Similarity Test". 

3. Added a graphical user interface for preparing the individual rotation angles. 

4. Added a notification function using email. 

 

Dock Viewer ver. 1.13: 

Changes in version 1.13 

1. Added the "Import Molecular Surface" and "Export Molecular Surface" functions to the "Tool" menu. 

Changes in version 1.12 

1. Improved the "Define" command of the "Ligand Color" and "Selection Color" options. 

Changes in version 1.11 

1. Added the "Select Protein" function to the Option menu. 

2. Changed the color of the cell corresponding to the selected compound in the "Browse Compounds" 

window. 

3. Added the "Export Selections" function to the "File" menu. 

4. Added the "Secondary Structure Color" function to the Option menu. 

5. Added a rendering function to the "Secondary Structure" command in the "Tool" menu. 

6. Added the "Define" color option to all coloring functions in the "Option" menu. 

Bugs fixed in version 1.11 

1. Fixed a problem for the "Z-Clipping" option. 

Changes in version 1.10 

1. Added the z-clipping function to the "Tool" menu. 

2. Added a function to display molecular surface under the "Show Selection Only" condition. 
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Bugs fixed in version 1.10 

1. Fixed a problem for the "Clear Surface" option. 

2. Improved response of the "Browse Compounds" window. 

Changes in version 1.09 

1. Added the selection target option to the main window. 

Changes in version 1.08 

1. Improved a function for the molecular surface. 

Changes in version 1.07 

1. Added a series of functions with respect to the molecular surface. 

Changes in version 1.06 

1. Added the "Selection Color" option. 

2. Improved the automatic rendering function. 

Changes in version 1.05 

1. Added automatic rendering function. 

2. Added the selection function for water molecules. 

 

Mol Dimension ver. 1.05: 

Bugs fixed in version 1.05 

1. A problem arising from a compound that has an abnormal structure was fixed. 

 

Revision A1 

 

Revision A1 is the first release version of the package. 

 

Control Center DS ver. 1.02: 

Changes in version 1.02 

1. Changed the maximum size of the physical memory for the PIEFII module program. 

Changes in version 1.01 

1. Added a function which can attach hydrogen coordinates into a PDB file when the "Save As" command is 

used. 

 

Geometry Correction DS ver. 1.12: 

No Changes. 

 

PIEFII Limited ver. 2.20: 

Bugs fixed in version 2.20 

1. Fixed minor bugs. 

Changes in version 2.19 

1. Changed a byte-order. 

 

Docking Study ver. 3.02: 

Bugs fixed in version 3.02 

1. A problem which HyperChem shows the warning messages,"Out of Memory," was fixed. 

Changes in version 3.01 

1. Added the "Restart" function which can restart the docking simulations from a desired conformation of a 

trial compound. 

2. Added some single-point calculations for estimating the precise interaction energy of simulations. 

3. Changed an output information. 

Bugs fixed in version 3.01 

1. A problem which was derived from the combinations between the molecular mechanics and the 

semi-empirical molecular orbital calculations was fixed. 

Changes in version 2.98 

1. Added the "Update Semi-empirical Charges" function which can renew atomic charges of a trial 
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compound at each conformation. 

Changes in version 2.96 

1. Changed a byte-order. 

2. Added the "Topological Similarity Check" option which is a high-speed technique for assigning a docking 

mode. 

3. Changed treatment for a coordinate system of the complex under the flexible docking condition. 

Bugs fixed in version 2.97 

1. Fixed minor bugs. 

Bugs fixed in version 2.96 

1. Improved a sort function of an interaction energy in the first geometry optimization process. 

2. Improved the "Automatic" option of the final optimization conditions. 

 

Dock Viewer ver. 1.04: 

Changes in version 1.04 

1. Added the "Browsing" mode for viewing the stable complexes. 

Bugs fixed in version 1.03 

1. Fixed minor bugs. 

 

Mol Dimension ver. 1.04: 

Changes in version 1.04 

1. The program can correctly convert a chiral center at which a hydrogen atom is attached in the 

corresponding 2D structure. 

2. Added a function which can convert a guanidino group to the corresponding guanidinium ion. 
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